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Introduction 
Aims and Learning Outcomes 
Through an exercise scenario in which a researcher needs to identify a set of fieldwork sites, 
this practical will provide a hands-on demonstration of best practices for research data 
management within the Esri ArcGIS Pro Desktop GIS software. 

Upon completion of this practical you should have:  

• gained practical experience of setting up a Geodatabase in ArcGIS Pro for the storage 
and processing of research project data 

• gained practice in documenting data processing steps carried out within ArcGIS Pro 
• an understanding of the strengths and weaknesses of different GIS data formats at 

different stages of the data lifecycle 
• gained familiarity and practice in using and creating geospatial metadata records within 

ArcGIS Pro 

 

Requirements 
Access to ArcGIS Pro 3.3.x or 3.4.x software is required.  

University of Edinburgh users can access ArcGIS Pro via these methods: 

• for managed devices: via the Software Centre on their device 
• for non-managed Windows devices: log in to the University’s SSO ArcGIS Online 

portal, click on your profile in the top right and go to ‘My settings’, then the ‘Licenses’ 
tab, where a ‘Download ArcGIS Pro’ option will appear 

• for other devices: (e.g. Mac or Linux) using the Remote software option 

All data used during the exercise is provided in the ‘MANTRA_ArcGIS_TutorialFiles.zip’ file. You 
will also need a suitable amount of disk space to store data during the practical. 

 

Datasets and Provenance 
This practical uses example geospatial datasets to demonstrate the principles of research data 
management. These datasets have been derived from the following sources: 

• Scottish landform points provided in csv format and derived from OS Open Names 
dataset. Provided by Ordnance Survey and available under the Open Government 
Licence. 

•  West Highland Way polyline data provided in shapefile format. Hosted and maintained 
by Stirling Council and provided under the Open Government Licence. 

• Ordnance Survey’s OS Terrain 50 product, downloaded and processed in ASCII Grid and 
GML format and provided under the Open Government Licence. The processing of this 
layer involved use of the OS Boundary-Line product hosted by Esri UK on ArcGIS Online. 

https://eduni.maps.arcgis.com/home/index.html
https://eduni.maps.arcgis.com/home/index.html
https://www.ed.ac.uk/information-services/computing/desktop-personal/remote-software
https://osdatahub.os.uk/downloads/open/OpenNames
https://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
https://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
https://opendata.scot/datasets/stirling+council-open+data+-+the+west+highland+way/
https://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
https://www.ordnancesurvey.co.uk/products/os-terrain-50
https://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
https://eduniv.maps.arcgis.com/home/item.html?id=9dc28220fa9a43cb869af77c0ac484c8&sublayer=1


Scenario 
A researcher needs to carry out fieldwork in the Scottish Highlands and wishes to use multi-
criteria evaluation analysis within ArcGIS Pro to determine the location of a set of fieldwork 
sites.  

Criteria for the selection of fieldwork sites is that they form a significant part of the natural 
landscape feature – that they appear as named hills or mountains on the Ordnance Survey’s 
Open Names dataset and that they are both visible from and within close proximity (1km) to a 
section of the West Highland Way long distance footpath. In identifying the sites from the 
provided data, best practices for research data management within ArcGIS Pro will be explored. 

 

  



Exercise 1: Setting Up a New Project and Importing to a 
Geodatabase 
1. As part of this practical you should have been provided with a zip archive called 

MANTRA_ArcGIS_TutorialFiles.zip.  
 

Extract the contents of MANTRA_ArcGIS_TutorialFiles.zip to a folder on your computer 
which both you and ArcGIS Pro are able to write to. This folder should not be within your 
OneDrive, and the file path should avoid using spaces (see Learning Point below). This 
folder will be the location where you save any data that you create during the practical. 
 

Learning Point: Filenames and Cloud Storage  
The software behind ArcGIS Pro has evolved from command-line based terminal applications to 
the GUI based ArcGIS Pro program that we use today. Official guidance1 on ArcGIS Pro 
recommends avoiding using filepaths which contains spaces, such as the Windows My 
Documents folder. In most cases this is unlikely to cause issues however. 

Furthermore, cloud storage platforms like OneDrive or Google Drive are currently not supported 
across the software suite. Common issues such as data loss or version inconsistencies may 
occur when files are accessed by multiple persons or when files are altered due to cloud 
synchronisation processes. Instead, users are encouraged to edit local copies of data, and save 
regular backup copies to cloud storage locations outside of edit sessions. 

Esri have stated they are aiming to enhance cloud storage integration in upcoming versions. 

 
2. Launch ArcGIS Pro. In the launch screen, under ‘New Project’, click on ‘Map’.  

 

 

ArcGIS Pro launch screen 

 
Give the project the name ‘Mantra_Workspace’ and set the location to be the folder you 
saved the zip file to in step 1. Untick the ‘Create a folder for this local project folder’ box 
then click ‘OK’. 

 
1 Link to the Esri community discussion 

https://community.esri.com/t5/arcgis-pro-questions/it-s-2024-how-does-arcgis-do-with-spaces-in-file/td-p/1387382#:~:text=In%20ArcGIS%20Pro%2C%20ArcMap%2C%20and,difficulty%20accessing%20such%20file%20paths


 

ArcGIS Pro New Project screen 

 

Notice that creating a new project will create a number of new files in your working 
folder. These are: 

• .aprx – The project file. This stores the locations of the data in the map, the 
styling and other map settings. 

• .gdb- The file geodatabase. This is for the storage of data which you will use in 
your project. 

• .atbx – A toolbox file. This can be used to store custom geoprocessing tools. 

Learning Point: Projects 
A project is a self-contained environment in which one can work with geospatial data. It is a 
collection of related items which could include maps, 3D scenes and layouts, as well as data 
paths and connections which give access to the populating data. 

Now we have created a project file we have a space to work with our data. In previous iterations 
of ArcGIS software, data management tasks would be done in a separate program (ArcCatalog) 
to mapping tasks. With ArcGIS Pro however, these functionalities have been combined into one 
program. 

 

3.  Now we have created a map, we need to think about co-ordinate systems. 
 
Because this exercise is looking at data in Scotland, we will use the British National Grid 
(BNG) coordinate system. This is the recommended coordinate system when working with 
data in Great Britain, and it is the coordinate system for the data used in this project. 
 
Double click (or right click) on ‘Map’ in the Contents panel on the left-hand side to launch 
the Map properties window. In ‘General’ we will give our map a name, as you can store 
multiple maps within one project. In the ‘Name’ field rename the map ‘Identifying Fieldwork 
Sites’. 
 
Then click on the ‘Coordinate Systems’ tab in the same window. Ensure ‘Current XY’ is set 
to ‘British National Grid’. If not, use the search bar and expandable menus to find British 
National Grid and double click so it appears in the ‘Current XY’ box. Then click ‘Apply’ and 
‘OK’ to close the window. 

 



 

Map Properties window 

 
 

Learning Point: Projections and Coordinate Systems 
Maps are 2D representations of the Earth which is a 3D spheroid. This loss in dimensionality 
results in compromises in how we represent certain qualities of the planet. For example, maps 
used for navigation may preserve direction and angles but distort the area of landmasses. No 
map is a perfect representation, however thinking about the extent and purpose of a map 
enable you to choose a projection – a conversion from spherical to planar – which will best suit 
your needs. ArcGIS Pro comes preloaded with many projection systems, as well as the ability to 
import or create new ones and carry out transformations between systems. 

Some examples of projection systems stored in ArcGIS Pro: 

• British National Grid – the recommended coordinate system when working with data 
located in Great Britain 

• WGS 1984 Web Mercator (auxiliary sphere) – a common default for global datasets, 
preserves direction but distorts area (particularly closer to the poles) 

• Spilhaus Ocean Map in Square – used for looking at global ocean-centric data which 
distorts land but joins the oceans into one visually-continuous area 

In the Map Properties panel accessed in the previous step, you may want to right click and 
select ‘Add to Favourites’ for any coordinate systems you might use regularly for ease-of-
access. You can also set the default coordinate system for ArcGIS Pro by going to ‘Project’ in 
the top menu, then opening the ‘Options’ window from the sidebar and clicking to ‘Map and 
Scene’ under Application. Expanding ‘Spatial Reference’ will then open the panel for the default 
setting. 

In ArcGIS Pro, setting the coordinate system of the map means that any data brought into the 
map will be automatically projected into the coordinate system of the map regardless of what 
the coordinate system of the underlying data is. This allows a high degree of flexibility when 
working with data from a variety of sources, however it is worth noting that in some cases you 
will want to transform the data itself into a new coordinate system for performing analysis. 
Additionally you will want to check that the Transformation the map uses is desired, however 
that lies outside the scope of this practical. 

 

https://www.gov.uk/government/publications/uk-geospatial-data-standards-register/national-geospatial-data-standards-register#coordinate-reference-system


 

 

Add Shapefile of West Highland Way 
4. Now we will import some of data we will be working with. Look in the ‘Catalog’ pane docked 

on the right-hand side - this is where the organisation structure of the project is displayed. If 
the Catalog Pane is not visible in the right hand panel then it can be added by going to the 
View tab and selecting Catalog Pane in the Windows group. 

 
Expand the ‘Databases’ folder to see the database that was created with the project. 
 
Right click on ‘Mantra_Workspace.gdb’ and click ‘Import’ then ‘Feature Class(es)’. This will 
replace the Catalog pane with the Geoprocessing pane, but you can toggle between them 
using the tabs at the bottom of the pane. 
 
To the right of ‘Input features’, click the folder icon to open a navigation window. Navigate to 
the location of the unzipped data from step 1.  
Open the folder named ‘open_data_-_the_west_highland_way’ and double click to select 
the file ‘open_data_-_the_west_highland_way.shp’. 
 
The default output location should be the ‘Mantra_Workspace’ geodatabase, which is what 
we want. If it is not, set the Output Geodatabase to be Mantra_Geodatabase.gdb. Click 
‘Run’.  
 
When complete, a green tick will appear at the bottom of the window. Toggle back to the 
Catalog pane and, if necessary, right click on ‘Mantra_Workspace.gdb’ and click refresh. 
The imported data should now appear in your file geodatabase. 
 
Right click on the data (‘open_data___the_west_highland_way’) and click Rename (or hit F2) 
and call it ‘West_Highland_Way’. 
 
Note: Spaces are not permitted in the names of features within geodatabases. 
 

Learning Point: Geodatabases 
A Geodatabase is a way of storing a collection of geographic datasets, including datasets of 
different types. Points, polyline and polygon feature classes as well as tables can be created or 
imported into a Geodatabase. Once imported these features will share a common path; this 
can be helpful for updating filepaths en masse in a project and managing data collections. 

We have successfully imported the route for the West Highland Way. Look in the folder which 
contained the shapefile and notice there is an .xml file with the same name – this file contains 
the Metadata which was supplied by Stirling Council along with the shapefile. We are going to 
now import this so it is stored with our data. 

 



Learning Point: Metadata  
Metadata is data about data. By extension geospatial metadata is data about geospatial data. It 
has two main purposes – it provides a record of how a particular geospatial dataset has been 
created (and maybe from what other geospatial dataset it has been derived) and it provides a 
bibliographic record to facilitate the discovery and sharing of that geospatial dataset by others.  

There are a number of different geospatial metadata standards in use today. Within the UK the 
UK Gemini 2.3 metadata is the standard for geospatial data.. Although ArcGIS Pro does not 
support UK Gemini directly, it supports a number of similar standards that can be chosen as the 
default template from the Options → Metadata menu.  Even if not created as UK Gemini it is 
possible to Export metadata from ArcGIS Pro into UK Gemini 2.3 using the Export → Metadata 
option2 although you will need to update any metadata to ensure it is Gemini 2 3 compliant. 

ArcGIS Pro contains its own internal metadata template, which is what we will use in this 
exercise.  

Information about the UK Gemini standard can be found from links on this government website  

 

5. Within the Databases section of the Catalog pane, in our working geodatabase, right click 
on the new ‘West_Highland_Way’ feature class and select ‘View Metadata’. A Catalog 
window will open. Make sure the ‘West_Highland_Way’ layer is selected – notice that there 
is currently no Metadata associated with this layer. 

 
In the top ribbon, in the ‘Metadata’ section (not the Create section), click ‘Import’. In the 
pop up, under ‘Import metadata from’, navigate to the and select ‘open_data_-
_the_west_highland_way.xml’ file. Under ‘the type of metadata to import’ select ‘Discover 
the type for me’, then click OK. 
 

 

Catalog ribbon 

The Metadata tab should now be populated with information about the data. Take some 
time to look at the kind of information that is included in the Metadata tab, and toggle to the 
‘Geography’ and ‘Table’ tabs to see how it presents the extent and content of the data. 
When you’re done, close the ‘Catalog’ tab at the top by clicking the small ‘x’ to return to the 
map view. 

 
2 See here for information on exporting metadata Gemini 2.3 and to other standard formats 

https://www.gov.uk/government/publications/uk-geospatial-data-standards-register/national-geospatial-data-standards-register#geospatial-identifiers-and-metadata
https://resource.esriuk.com/blog/gemini-2-3-metadata-in-arcgis-an-update/


 

The metadata window 

6. Right click on the layer in the Geodatabase in the Catalog tab and click ‘Add to Current Map’ 
to add the data to the map. The polyline will appear on the map, showing the route of the 
West Highland Way. The layer will also appear in the Contents panel on the left side of the 
screen. 

 

 
The West Highland Way 

The data is now being used by the map, but it is still stored within the geodatabases. Any 
changes to the content of the data itself (e.g. the shape of the route, any attributes, etc…) 
will change the underlying data in the Geodatabase. Any changes made to the layer in the 
map (e.g. colour of the line, layer name, labelling etc) will only save to the map. 



7. In the Contents pane, untick the box next to the ‘West_Highland_Way’ layer. The path will 
disappear from the map, however the layer still appears in our contents pane. This box 
determines if the layer is visible in the map. It can be helpful to untick layers you are not 
currently working with if your visual display is becoming cluttered. All the associated layer 
information will remain as long as you do not remove the layer from the map. Tick the box 
again to make the path visible. 

 

Review Scenario 
Let’s think about our scenario again. We are interested in identifying a set of fieldwork sites that 
meet a set of specific criteria, so our analysis will be undertaken under a methodology known 
broadly as Multi-Criteria Evaluation (MCE). MCE is an analytical means of making selections 
based on specific criteria. Here our criteria are that the fieldwork sites: 

• appear as a named hill or mountain in Ordnance Survey’s Open Names dataset. The 
rationale being that such features are culturally significant and represent important 
landscape features. 

• are visible from the path of the West Highland Way long distance footpath. 
• are within a certain distance (1km) of the West Highland Way long distance 

footpath. The rationale being that we do not want to have to walk far from the 
footpath if we are carrying specialised and perhaps cumbersome fieldwork 
equipment as part of the research. 

We will carry out this analysis interactively using tools within ArcGIS Pro. The data we have from 
OS Open Names will represent candidate locations for the fieldwork sites and we will refine this 
data to ensure that any candidate points are also visible from the West Highland Way and lie 
within 1km of the footpath. We’ll undertake the analysis one step at a time. 

 

Add Terrain Data 
8. In the Catalog pane, expand the ‘Folders’ menu and the successive folder structure until 

you find the one containing  the data for the exercise. (Alternatively you can right click on 
‘Folder’ and select ‘Add Folder Connection’ if the current folder does not contain your data). 
Navigate to the subfolder named ‘Scotland_DTM_data’, then right click ‘scotland_dtm.tif’ 
and click ‘Add to Current Map’. The Digital Terrain Model  (DTM) will appear on the map, with 
shades of grey indicating the relative elevation of land in Scotland. 



 
Imported DTM 

 

 
9. Right click on the ‘scotland_dtm’ layer and click View Metadata. This metadata should 

automatically be populated from the metadata file, as it was created in ArcGIS Pro. Take a 
minute to read the information, then close the Metadata tab when ready. 
 

Add CSV Data 
Finally, we are going to import the OS Open Names data, as this will form the basis of the 
potential fieldwork sites layer. This data will come from a different kind of source file: a CSV 
(Comma Separated Value) file.  

10. In your file explorer, open the csv named ‘Scottish_landform_features.csv’ within the 
‘opname_csv_gb’ folder. It contains thousands of rows of data. Two of the columns in the 
document (GEOMETRY_X and GEOMETRY_Y) are co-ordinates, meaning this data can be 
geospatially located and imported into ArcGIS Pro.  

 
Note: This data has already been refined from the original OS source data to only include 
points which have a ‘Country’ field value equal to ‘Scotland’ and a ‘Type’ value equal to 
‘landform’. 
 
Close the CSV document and navigate back to ArcGIS Pro. 
 



11. In the Catalog pane on the right, under Folders, navigate to the location of the csv we just 
opened. Right click on the file then click ‘Export’ and ‘Table to Point Feature Class’. This 
will open the Geoprocessing tool we will use to convert the table into a geospatial dataset. 

 
12. The Input table will be populated for you, check it references the correct csv. Make sure that 

the output path matches your working Geodatabase and rename the output 
‘Scottish_landform_features’.  
 
E.g. 
C:\Users\Documents\ArcGIS\Projects\Mantra_Workspace\Mantra_Workspace.gdb\Scottis
h_landform_features’ 
 
The X and Y fields should automatically populate with the ‘GEOMETRY_X’ and 
‘GEOMETRY_Y’ fields, but if not select these from the corresponding drop down menu. 
 
Finally we must inform ArcGIS Pro which coordinate system the input data is stored in – in 
this case British National Grid. Click the drop down box and click on ‘Current Map’. As we 
set the coordinate system of the map earlier, this should then display 
‘British_National_Grid’ in the box. 
(Alternatively you can click the globe to the right of the box to select the coordinate system 
manually.) 
Click Run. 
 

 

                 The imported landform features as points 

13. Finally, we need to import the metadata for the landform points layer. Follow the same 
steps as earlier to import the metadata file ‘landform_features.xml’ found in the same  

 

  



Exercise 2: Query Data, Derive New Datasets and 
Perform Multi-Criteria Analysis 
 

Criteria Review 
At the end of the last exercise we imported all the landform points in Scotland. This dataset will 
form the basis of our potential fieldwork sites. The criteria for the fieldwork points are: 

• must appear as a named hill or mountain in Ordnance Survey’s Open Names dataset. 
• must be visible from the path of the West Highland Way long distance footpath. 
• are within 1km of the West Highland Way long distance footpath. 

We will begin by fulfilling the first criteria. A fieldwork site should be a hill or mountain but 
currently we have points for all landform features in Scotland. We need to query the data to 
select hill or mountain features only. To do this we are going to export the hill and mountain 
features from the dataset to create a new data layer: 

 

Find Named Hills or Mountains 
1. In the Contents pane on the left, right click on the ‘Scottish_landform_features’ layer and 

click ‘Data’ then  ‘Export features’. Name the Output Feature Class 
‘Potential_Fieldwork_Sites’. Then click to expand the Filter section of the window. 

 
2. Use the Expression tool to build the following expression: Where LOCAL_TYPE is equal to 

‘Hill or Mountain’.  
Note: Toggling the SQL panel will switch to using SQL syntax to build your query. In this 
instance the query becomes: LOCAL_TYPE = 'Hill Or Mountain'. Click the green tick above 
the box to check the expression is valid (a good habit to practice) and then click ‘OK’. The 
new layer should automatically be added to the map. 

 
3. In the Contents pane right click on the ‘Scottish_landform_features’ layer and click 

‘Remove’.  

We have successfully created a layer which contains hills and mountains from the OS Open 
Names data, meeting one of our three criteria. Now we will look at the second criteria and 
find which points are visible from a section of the West Highland Way. To do this we must 
first create a viewshed layer. 

 

Visibility from West Highland Way 
A viewshed is a geographical region which is visible when looking outwards from one or 
more input points. In our case the viewshed will be the landscape observable from the route 
of the West Highland Way footpath. Viewsheds are calculated by comparing locations with 
an underlying terrain surface held in a Digital Terrain Model (DTM), such as the one we have 
previously added to our map. 



4. Click on the ‘Geoprocessing’ tab of the Catalog pane and search for ‘Viewshed’, then click 
on ‘Viewshed (Spatial Analyst Tools)’. Populate the tool with the following properties: 

• For the ‘Input Raster’, click the down arrow then select the ‘scotland_dtm’ layer 
from the list of map layers. 

• For ‘Input point or polyline observation features’, click the arrow and select the 
‘West_Highland_Way’ layer. 

• For ‘Output Raster’, click on the folder then ensure you are pointing to our 
working geodatabase and give the output file the name ‘Viewshed_from_WHW’. 

Leave the remaining inputs on their default values and click run. This process may take 
several minutes to complete. The output layer will be added to your map when completed. 

  

The map containing the viewshed and the DTM 

Now we have created the viewshed layer, we want to filter our potential fieldwork points to 
identify those that intersect with this viewshed layer. 

5. We want to run the Select by Location tool to find potential fieldwork locations with the 
viewshed, however before we do this we need to convert the raster viewshed layer to a 
vector polygon layer. 

Learning Point: Data types  
Geospatial data comes in two main types: vector and raster. Vector data - points, lines, and 
polygons - denote discrete locations, paths, and areas. Raster data is composed of pixels with 
assigned values and are used to represent continuous data such as satellite images and digital 
terrain such as the DTM we saw earlier. 

To learn the data type of a layer, right click on the layer and click ‘Properties’ to open the Layer 
Properties window. In the Source tab, under the Data Source there will be a table, the first entry 
of which will say Data Type and have the corresponding data type. In this window you can also 
see the source of the data, which can be helpful to ensure you are working with the expected 
data. 

We will convert the raster viewshed layer into a polygon layer which we can input to this 
tool. This will be suitable for our analysis as we want to find a site that is visible from some 
point along the West Highland Way, so we don’t mind losing the raster information 
regarding how many places a spot is visible from. It is always worth considering when 



performing a data conversion what data might be lost in processing, and if the output data 
will still meet your requirements. 

6. Open the Geoprocessing tab of the pane on the right-hand side and search ‘Raster to 
Polygon’ then click to open the tool with that name. For ‘Input raster’ select the 
‘Viewshed_from_WHW’ layer and give the Output polygon features the name 
‘WHW_Viewshed_polygon’. Leave the rest of the inputs on their default values and click 
run. 

The output should be added to the map. The new polygon layer looks like it contains lots 
more areas than before, but this is because the raster data also included zero area – where 
the area was not visible from the West Highland Way but the shape of the area was 
retained.  

7. Toggle off the visibility of the old raster layer (‘Viewshed_from_WHW’) and the DTM layer 
(‘Scotland_dtm.tif’). 
Right click on the ‘WHW_Viewshed_polygon’ layer in the Contents pane and click ‘Attribute 
table’, a table will open showing the data contained in that layer. In this case, we want to 
remove areas with a ‘gridcode’ area of ‘0’. 

 
One method to do this would be to export data from our layer as we did earlier when 
identifying the ‘hill and mountain’ landform features. We will follow another method which 
will edit this layer rather than creating a new one, as this polygon now lies within our 
geodatabase so it represents a local copy we can easily edit.  

 
8. Making sure you are on the ‘Map’ tab of the top menu, click ‘Select By Attributes’. Ensure 

the Input Rows are set to ‘WHW_Viewshed_polygon’ and the Selection Type is ‘New 
Selection’. Build a query which will select rows with a gridcode value of 0 (Where gridcode is 
equal to 0’). Validate the expression then click Apply. Notice that rows in your open 
attribute table have been highlighted in blue, as well as the corresponding areas in the map.  

 



 

Select by Attributes 

 
9. Click ‘OK’ to close the selection pop-up window, then in the attribute table window click 

‘Delete’ (circled in screenshot above) to delete the selected rows. Once this action has 
completed, navigate to the ‘Edit’ tab in the top menu and click ‘Save’ in the Manage Edits 
section to save this deletion. These rows have been removed from our polygon data layer, 
leaving the remaining areas representing the ‘true’ viewshed.  
 
Close the ‘WFW_Viewshed_polygon’ attribute table by click the ‘x’ next to the name at the 
top of the table. 

 
One additional option step could be to ‘dissolve’ the viewshed into one continuous polygon 
which represents the viewshed as a whole – however that will not be necessary for our 
purposes. If you like, feel free to give this a try using the ‘dissolve’ Geoprocessing tool. 

 
Now we are ready to do the selection on the potential fieldwork points to see which lie 
within the viewshed. 

 
10. Open the Attribute Table for the ‘Potential_Fieldwork_Sites’ layer (right click in Contents > 

Attribute table). 
 

11. Navigate back to the ‘Map’ tab of the top menu and click on ‘Select by Location’ within the 
‘Selection’ group. For Input Features select ‘Potential_Feildwork_Sites’ and for Selecting 
Features select the ‘WHW_Viewshed_polygon’ layer. We will leave Relationship as 
‘Intersect’ as we are only interested in points which intersect the viewshed, and are 



therefore visible from the West Highland Way. Leave the remaining settings as default and 
click ‘Apply’ then ‘OK’. 

As with before, the potential sites have been highlighted in blue. We could export these 
points to a new file, or we could delete the points which are not selected. We will do the 
latter. 

12. At the top of the attribute table (for the Potential Fieldwork points) click ‘Switch’ – this will 
reverse the current selection – then click ‘Delete’. Once this is complete only 1,408 points 
should remain in your dataset, as indicated in the bottom left of the attribute table. Save 
these changes in the Edit tab as before. Then toggle off the visibility of the 
‘WHW_Viewshed_polygon’ layer. 

 

Switching the selection will highlight those points which do not intersect with the viewshed 

Limit Points to within 1km of West Highland Way 
We have narrowed the number of potential fieldwork sites down to those hills and mountains 
which are visible from the West Highland Way. Now we want to limit these points further to 
those which are within 1km itself of the walk route. 
 
One way to do this would be very similar to the step before and use a ‘select by location’ 
between the fieldwork points and the West Highland Way polyline. In this method, you would 
need to switch the relationship type from ‘Intersect’ to ‘Within a distance’ before entering 1km 
as the Seach Distance, since the points will not necessarily intersect the West Highland but lie 
within a fixed distance from the line. 

This is a valid way to proceed, however for additional context in our output map we may want to 
include a visual representation of a 1km buffer of the West Highland Way. Because of this, we 
will instead first make the buffer and then use an intersect between the points and the buffer to 
select our final fieldwork site candidates. 



 
13. In the Geoprocessing tab on the right hand side, search for the ‘Buffer’ tool and open it. Set 

Input Features to the ‘West_Highland_Way’ layer. Name the Output Feature Class 
‘West_Highland_Way_1km_Buffer’. Set the distance to ‘1’ and the unit to ‘Kilometers’ [Note: 
the US English spelling here for units]. Accept the remaining default parameters and click 
Run. 

Now that we have the buffer layer, we will run another selection on our potential fieldwork 
point layer to narrow down to the points which are also within 1km of the West Highland 
Way. 

14. Navigate to the ‘Map’ tab of the top menu and click on ‘Select by Location’ within the 
‘Selection’ group. For Input Features select ‘Potential_Fieldwork_Sites’ and for Selecting 
Features select the ‘West_Highland_Way_1km_Buffer’ layer. Leave Relationship as 
‘Intersect’ and the remaining settings as default and click ‘OK’. 

 
15. Ensure the Potential_Fieldwork_Sites attribute table is the open attribute table (opening it 

again if not) and again, at the top of the table, click ‘Switch’ then ‘Delete’ to remove all 
unselected features. There should be 27 points left in the dataset – and these represent our 
shortlist of Fieldwork sites. Save these changes in the top Edit tab as before, then save the 
project. 

 

Summary of Finding Potential Fieldwork Sites 
Let’s review what we’ve done in this Exercise. Our criteria for fieldwork sites are: 

• must appear as a named hill or mountain in Ordnance Survey’s Open Names dataset. 
• must be visible from the path of the West Highland Way long distance footpath. 
• are within 1km of the West Highland Way long distance footpath. 

We started with a set of points representing all landform features in Scotland from the OS Open 
Names layer. We then exported to create a new layer containing a subset of points representing 
hills or mountains. This fulfils the first of our three criteria. 

We then ran an intersect on these points with the viewshed layer, which represents areas 
visible from the West Highland Way, and removed any points which were not in this intersect. 
This fulfils the second criteria. 

Finally, we created a 1km buffer around the West Highland Way and removed any points which 
did not lie within this buffer. That fulfils the third of our criteria. 

We have successfully identified 27 potential fieldwork sites and have created a layer containing 
these points. 

In the next exercise, we will look at tidying our data and improving the visualisation of our map. 

  



Exercise 3: Organising and Styling a Map 
 

Map Content 
We’ve now identified the 27 potential fieldwork sites for our project. Let’s neaten up our data 
and present the information in the map in a way that’s easy to understand. 

We’ll start by removing some layers from our Contents pane. The data for the buffer and 
viewshed layers will still exist in their source location and we will re-add them later.  

Right click and remove any layers except for: 

• Potential_Fieldwork_Sites 
• West_Highland_Way 

If necessary, drag and reorder the layers in the Contents pane to reflect the order above. This 
represents the ‘Drawing Order’ for the map, with layers at the top displayed ‘above’ those 
below. 

The name of a layer in a map is independent of the data source’s filename, so these can contain 
characters such as spaces. Highlight the remaining layers in turn and press F2 (or right-click > 
Properties > General tab) to rename the layer, replacing underscores with spaces and giving the 
layers names that clearly convey what they are. 

 

Working with Fields 
1. If not already open, open the Attribute Table for the Potential Fieldwork Sites layer. Here we 

can see the fields at the top and the corresponding data. Explore this table a little. 

Learning Point: Fields  
In geospatial data a field refers to an attribute in a dataset that holds data associated with 
spatial features. Each field will contain specific information about the features, for example 
names, dates or numerical values. 

It’s good to know what data is contained within your layer. You want to ensure that necessary 
fields are included with the correct data type, and similarly, you may want to ensure some data 
is not included. For example you may create a public facing dataset which is derived from data 
originally containing sensitive information. It would be important to ensure that this data was 
removed before you proceeded with sharing. 

The field headings in our Potential Fieldwork Sites layer came from the original OS data and 
convey what kind of data is stored in that field. Let’s rename a few to make it a bit clearer, 
and remove fields which we’re not interested in. 

2. Right click the Potential Fieldwork Sites layer in the Contents pane and click ‘Data Design’ 
then ‘Fields’. This brings up a table which contains information about the fields contained in 
this layer. 

 
There are currently a lot of fields which we don’t need in our final output. Click on a row 
using the box in the far left of the table, the corresponding row will highlight in blue. You can 



then click ‘Delete’ in the Edits group of the Fields tab in the top menu. Using the Shift and 
Ctrl keys to select multiple rows at once, delete all the rows except for the following: 

• OBJECTID* 
• Shape* 
• ID 
• Name1 
• LOCAL_TYPE 
• GEOMETRY_X 
• GEOMETRY_Y 
• COUNTY_UNITARY 

*Note: these are essential fields that cannot be deleted, hence its faded grey colour. 
Notice that deleted rows are now in strikethrough font type. Any row that has been altered in 
this edit session also has a green box in the left of the table. 

 

Deleting fields from the dataset 

3. Commit the changes by clicking ‘Save’ in the Manage Edits group of the Fields tab in the top 
menu.  

Now we will give a new alias to some of our remaining fields. 

Notice the Field Name and Alias columns in the Fields design table – currently these have 
the same values. The field name value is what is used in programming languages to 
reference that field whereas the alias is a reference name only used for display purposes. 
As a result, the alias can contain special characters whereas the field name must observe 
certain rules such as no spaces. 



4. Click into the alias column and change the following values: 
• NAME1 to Name 
• LOCAL_TYPE to Local Type 
• GEOMETRY_X to Easting 
• GEOMETRY_Y to Northing 
• COUNTY_UNITARY to County 
 

 

Editing the Alias of the remaining fields 

 
5. Click Save again in the Manage Edits group of the top menu. Close the Fields editing menu 

by clicking the x to the right of  the tab ‘Fields: Potential Fieldwork Sites’. If not already open, 
open the Attribute Table for the Potential Fieldwork Sites layer. 

You can see in the Attribute Table that our data is now looking a lot leaner and cleaner, and will 
also be a much smaller file in terms of storage size. The display names for the fields have also 
changed to reflect the alias values we gave, making the data easier to digest. 

 

  



Map Symbology 
We have now cleaned the output data feature. It is now time to consider the symbology and 
styling of our map. Maps, or perhaps 3D scenes, are the most natural ways to present 
geospatial data. Geospatial data exists in a geographical context - having it displayed in a map 
enables end-users to utilise the data to its full potential, spotting patterns or key information 
that would otherwise be obscured if it was left as only entries in a table. 

Learning Point: Symbology and styling   
The symbology of a map refers to the assignment of things such as colours, symbols and labels 
to features based on their attributes. Good symbology will differentiate and highlight various 
aspects of the data, enhancing the readability and interpretation of the map. On the other hand, 
bad symbology can actively mislead and misrepresent data, so it is important to consider if your 
styling choices are an accurate reflection of the underlying information. 

Styling is generally saved to the project file, not to the data itself. This means that removing a 
layer from your map and re-adding it means it will likely not come back with the same styling as 
before. 

We will start by customising the Potential Fieldwork Sites: 

1. Right click on the Potential Fieldwork Sites layer and select ‘Symbology’ to open the 
symbology pane on the right-hand side. 

The Primary Symbology is currently set to ‘Single Symbol’. This means that all the points in 
this feature set will be displayed the same way, which is fine for our purposes. If we wanted 
to set the symbology of points dependent on a field value, we would set this here. 

2. Click on the symbol which appears next to the word ‘Symbol’ to open a Format Point 
Symbol window. In this window we can customise the point that is used to represent the 
Potential Fieldwork Sites in lots of different ways such as altering the colour, shape, size 
and transparency of the point. Instead of creating our own symbol however, we are going to 
pick one from some in-built options. 

 
3. If necessary, navigate to ‘Gallery’ at the top of the Format Point Symbol menu. Here you will 

find a range of symbols which have been preloaded. New galleries can also be created or 
downloaded to have more premade options available for styling layers. From the gallery, 
select a symbol of your choice (e.g. red triangle) to represent these potential fieldwork 
points. 

 



 

A range of point symbology options in the Gallery 

Now we will edit the symbology of the West Highland Way layer. 

4. Right click on the layer in the Contents and open the Symbology pane. As before, click on 
the symbol to open the formatting pane and if required: navigate from the Gallery tab to the 
Properties tab. Try changing the colour and weight of the line until you find a combination 
which you like on the map. 

 
Note: we will be changing the polygon layers next, so you may want to come back and 
edit this symbology again later to ensure your chosen line styling stands out. 

 

Updated symbology for the map 

Finally, we are going to add in the buffer and viewshed polygons back in as layer files 

Learning Point: Layer files 
Esri has also developed files called layer files. These are files which do not contain data but 
contain styling for data as well as a relative data path. Because layer files reference an 
underlying dataset, rather than store the data, the layer may become broken if it loses reference 



to the underlying data such as the file path changing from one device to another. If this 
happens, the source for the data in the layer needs to be updated and pointed towards the new 
location. Once done the layer file will have associated data and will display the source data 
features with the symbology defined in the layer file. 

Note that layer packages also exist. These are filetypes where both the styling of the layer and 
the underlying data are saved to an output file. This means data sources will not break and the 
file is self-contained. One disadvantage to these is that it can be harder to track versioning - as 
the underlying data is saved to a file and will not update synchronously.  

5. In the right hand panel, navigate to the Catalog tab. Expand ‘Folders’ and find/expand the 
folder named ‘LayerFiles’ in the original source data. Hold Ctrl and click to highlight both 
the .lyrx files in this folder, then right click and select ‘Add to Current Map’. 

The layers will add to your map, however they will appear with a red exclamation mark  and 
not display visually. As mentioned earlier, this is because the data path that the layer file 
was exported with does not match the location of the data you have, so the layer file source 
must be updated. 

6. Click on the red exclamation mark for ‘West Highland Way (1km Buffer)’ and, in the pop up 
window, set the data source to be the equivalent layer in your working geodatabase. Repeat 
for the Viewshed layer then, if needed, reorder the layers in the Contents pane so that the 
order is: Fieldwork Points > West Highland Way > WHW Buffer > Viewshed. 

 

The Fort William area in the map 

Basemap 
Now we will consider the choice of basemap for our map. 

Learning Point: Basemap 
A basemap is an underlying layer which gives global or local context to your data. Instead of 
creating a map each time which contains local placenames and geography, we can utilise 
existing data to populate the background with this information. 



When choosing a basemap, you should think about what context you may want to give a viewer 
to help them understand the data best. Consider the various options such as: aerial imagery, 
topographic-focused terrain map or street labelled navigation focused. 

In our case, a more muted basemap might help our data stand out better. 

7. In the Map tab of the top menu, in the Layer group, click ‘Basemap’ to view the Basemap 
gallery. The default basemaps you see are determined by your organisation, however other 
custom basemaps can be imported or downloaded for use. Click on ‘GB Light Grey’ to set 
the basemap. 

The default basemap can be customised if you would prefer an alternative when you launch 
a new map. 

Save your Project at this point to save changes made to the Map 

 

  



Exercise 4: Creating a Metadata Record for Our Output 
 

We have our map and relevant data contained within it. Another task we should perform is to 
now create metadata records for the data we created. We’ll demonstrate this with the 
‘Potential Fieldwork Sites’ layer. 

1. In the right hand pane, if necessary, navigate to the Catalog pane and expand the 
Databases section and the Matra_Workspace.gdb so you can see the list of data 
contained within our working geodatabase. 
 

2. Right-click on the ‘Potential_Fieldwork_Sites’ layer and click ‘Edit Metadata’ to open the 
Metadata window. 

Notice that some of the metadata is filled in. This is because we created this layer from 
the Scottish Landform features dataset, so the metadata from there was inherited.  We 
should update this to reflect our new dataset. 

3. Set the Title of the layer to be ‘Potential Fieldwork Sites’. 
 

4. For Thumbnail, click ‘Update’ and upload the image in the data folder named 
‘FieldworkSites_Thumbnail.png’. 
 
Note: This was created was by making only this layer visible and taking a screenshot. 
 

5. Set the tags to be ‘Fieldwork Sites, Scotland’. 
 

6. Update the Summary to read: “Locations of Potential Fieldwork Sites, created during a 
MANTRA training exercise for Data handling in ArcGIS Pro.” 
 

7. Update the Description (Abstract) field to read: 
 
“Contains point features which meet the following criteria: 
 

• must appear as a named hill or mountain and lie within Scotland, from 
Ordnance Survey’s Open Names dataset. 

• must be visible from the path of the West Highland Way long distance footpath. 
• are within 1km of the West Highland Way long distance footpath. 

 
Created as a MANTRA training resource for Data handling in ArcGIS Pro.” 
 

8. Update the Credits to read:  
 
Derived from OS Open Names layer, provided under the Open Government Licence. 
 
Contains data derived from the West Highland Way polyline data, hosted and 
maintained by Stirling Council and provided under the UK Open Government Licence 
v3.0. 



Also contains data derived from Ordnance Survey’s OS Terrain 50 product provided 
under the Open Government Licence. 
 
Instructions for layer creation provided by EDINA, The University of Edinburgh. 
 

9. Click ‘Add Use Limitation’ and include the text: 
Must contain link to relevant licence for Open Government Licence and suitable credits. 
 

10. Adjust the ‘Appropriate Scale Range’ so the top end is ‘State’ and the bottom end is 
‘City’. This represents the approximate scales at which our data is appropriate for use. 
 

11. Click ‘Save’ in the top menu in the ‘Manage Metadata’ section. Then, close the 
metadata tab and return to the map. 

We have now created a metadata record which belongs with our output data. When sharing this 
data, the metadata will provide a record of what the data contained represents and how it was 
derived. 

If desired, repeat this exercise with the other layer in our map – making sure to adjust the 
information to accurately reflect the data contained. 

  

https://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/


Exercise 5: Sharing and Exporting 
Now we have out map and completed outputs, we will look at various ways we could share our 
map and associated data. There are many methods with which to do this, so will cover two 
methods: as an exported map and as files. 

Exporting a Map (Layouts) 
If your desired output is a map image or file, with no interactivity of data, then you may want to 
create a layout which contains your map and export this to an image or PDF file. This method is 
useful if you are creating a map which is to be used for display purposes, or inserted into a 
wider document. 

In order to our export our map, we will first create a Layout: an organised display usually 
consisting of a map (or maps) and supporting elements which give additional context (e.g. 
North arrows, scale bars, legends). 

1. If not already open, open the Matra_Workspace project in ArcGIS Pro. In the top menu, click 
on the ‘Insert’ tab then click on the ‘New Layout’ button in the ‘Report’ group. 

 
The drop down menu gives us a range of sizes, based on paper size, we can use to create 
our layout, as well as the option to customise the size. It is worth considering things such as 
the dimension and spread in your data, as well as how the exported map will be displayed, 
when selecting a layout size. 
 
For our map, we will use a standard A4 paper size. As the West Highland Way is a largely 
North-South pathway, we will display the data using portrait orientation. 
 
 Select ‘A4’ in the ‘ISO – Portrait’ section. 

 

 

Selecting the size of our layout. 

 

A new tab will open in the document containing the layout. If this tabs is closed, you can 
access the layout again via the ‘Layout’ folder of your Catalog Project pane. 



2. Double click on the name ‘Layout’ which appears under Drawing Order in the Contents 
panel on the left. A window for the Layout Properties will open. Click to the ‘General’ tab 
and rename the Layout ‘West Highland Way Fieldwork Sites’. Click OK. 

Now we have created our Layout, we need to insert our map which we previously stylised. 

3. In the Insert tab of the top menu, in the Map Frames group, click on ‘Map Frame’. Your 
existing map ‘Identifying Fieldwork Sites’ should appear as a heading category. Click on 
‘Default Extent’ then click and drag on the portrait page to create a map frame a little 
smaller than the boundaries of the page. 

 

Inserting the map frame to the layout 

 

Great, we’ve inserted the map to our layout. Now we need to adjust the map so it focuses 
on the area of interest. Right now if we click and zoom on the map, we will instead zoom on 
the layout. This is because right now the map is being treated as one static image. In order 
to alter the properties in the map, we need to ‘activate’ it within the layout. 

4. Click to the ‘Layout’ tab of the top menu and, in the Map group, click ‘Activate’. Zooming in 
and out now will zoom in and out on the map. 

 
5. In the bottom left corner of the layout frame is a scale bar. Click in and set the scale to 

‘1:500,000’. Then click and drag the map so the West Highland Way is centred. When you’re 
happy, click to the ‘Layout’ tab of the top menu and click ‘Close Activation’ in the Map 
section. 

 



 

Setting the scale of the map within the layout. 

 

Now we will add a little more information to our map. Having additional context can aid in 
end-users correctly understanding and interpreting your map. For example, this map could 
benefit from a legend indicating what our map symbology represents. 

6. Click to the ‘Insert’ tab of the top menu and, in the Map Surrounds section, click on ‘Legend’ 
(if you click on the down arrow then select ‘Legend 1’). Click and drag in the upper-right 
region of your map to insert the legend. 



 

Inserting the legend to the layour 

7. Let us now customise the legend a little. Right click on the legend in the layout and click on 
‘Properties’ to open an Element tab in the right-hand pane. 

 
In the panel that’s visible, tick the box under ‘Legend’ next to ‘Title’ which says ‘Show’ so the 
legend title now displays above our layer names. 
 
Next, at the top of the panel where there are icons, click the third icon with a paintbrush to 
open the Display section. Use the colour pickers to give the legend a black border and a 
white background, as well as 2mm of padding as shown in the screenshot below. 
 



 

The display tab of the legend menu 

8. If desired, play around with some of the other settings to customise the legend. You may 
also want to click and resize the legend in the layout to make it bigger, which will 
automatically resize the text and make it clearer. 

Now we will add a few more custom items to our map. Once again, feel free to experiment 
with what you would like to add. 

9. Making sure your are on the ‘Insert’ tab of the top menu, in the Map Surrounds group, add in 
a North Arrow and a Scale Bar similar to how we inserted the legend. Use the drop down 
arrows to choose a style you like and make sure to resize the scale bar so it displays a 
sensible range of distances. 

 



10. We are now ready to export our map. Click to the Share tab of the top menu and, in the 
Output group, click on ‘Export Layout’ (not the dropdown arrow but on the icon itself). This 
will open a panel on the right hand side where you can configure the output file. 

 
11. For ‘File Type’ select ‘JPEG’ and set the export path to be your working folder, giving the 

export the name ‘Mantra Worksites Map’. Most of the remaining settings can be left as 
default. One useful setting for reference is the ‘Resolution’ -  a higher value here will result 
in a crisper image (and a larger file size). Click Export when done then save the project. 

 

The exported layout. 

 



Exporting Potential Sites to a File 
Exporting to a file output can be useful when you want to share the underlying data with others 
who have access to GIS software. Many file outputs can be accessed using alternative 
software, such as QGIS, if someone does not have access to ArcGIS Pro and the Esri suite. We 
will look at exporting to Shapefile. 

1. If necessary, click back to the map tab named ‘Identifying Fieldwork Sites’ from the main 
central screen. 

 
2. Navigate to the Catalog tab on the right-hand panel. Expand the Databased folder, then 

expand the ‘Mantra_Workspace.gdb’ geodatabase to see the contents. Right click on the 
‘Potential_Fieldwork_Sites’ layer and click ‘Export’ then ‘Feature Class to Shapefile…’. 

 
3. The ‘Input Features’ will automatically populate with the filename from the previous 

selection. For the ‘Output Feature Class’, navigate to your working folder and name the file 
the ‘MANTRA_Fieldwork_Shapefile.shp’. Click Run. 

 

Learning Point: Shapefiles 
A shapefile is Esri’s file format for storing vector data outside of a geodatabase. They contain all 
the data for the vector such as location, shape, and attributes, all of which must share the same 
geometry type (e.g., point, line, polygon) and spatial reference. 

Shapefiles have a .shp file extension, however in reality they are usually a group of associated 
files which will have a common name and various file extensions. Three of these files are 
essential, these are: 

• .shp – the geometry for all features 
• .dbf – the attribute table for the data 
• .shx – the geometry index 

The remaining files serve to enrich the data further. These are: 

• .prj – the coordinate system and projection information for the data 
• .cpg – described the encoding of the shapefile  
• .sbn – a spatial index of the data 
• .sbx – a spatial index of the data 
• .shp.xml – the geospatial metadata 

When sharing shapefiles it is important to make sure you have grouped all of the associated 
files together in order to share them (e.g. put in a common folder and zip). At a minimum you 
must include the three essential files or the data will not be usable. 

 
4. Notice the MANTRA_Fieldwork_Shapefile.shp (and the associated files) from our export. 

These files could now be sent to someone (preferably in a .zip file), with the data contained 
for our potential fieldwork sites.  

 
Note: You may also notice LOCK files with the .lock extension. These files appear because 
the file they reference is currently open within ArcGIS Pro. They help ensure data integrity by 



preventing conflicting edits being made to a feature simultaneously. When you close your 
ArcGIS Pro project, these files will disappear. 

 
5. Save and close the project. 

 

 


